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Installation Guide

Installing Diamond Edition Software
Download the installation files.

Unzip the files at the computer on which you wish to install.

Run startup.exe – you can accept all the defaults (if you change the default destination folder, take 
note of it).

Once the installation is complete, you will need to run the Database Administrator tool to connect to 
an existing database or create your initial database.  While a shortcut will be available on the desktop, 
you will access the DBAdmin tool via the: 
Start Menu | All Programs | Diamond Edition | Tools | Database Administrator.

At the login window, click on the Configure button. If your company already has a database, you will 
point the program to that location (for instance N:\Data where “N” is a mapped network drive, and 
Data is a shared folder on the network). You will point to the folder just above the ODBC folder as the 
Common Directory. [You may need to consult with your company IT Dept for the Common Directory 
path, or you may be able to obtain it from the login screen of a computer already successfully running 
Diamond Edition Software.]

If you are running this program for the first time in your company, you can point to the location of your 
choosing for the Common Directory (on the network if you plan to share the database within your 
company, or locally on the computer’s hard drive if this is to be a stand-alone program & database).  
If this is the case, you will select next until you reach a list of missing tables at which point you will 
click on the checkbox next to “Fix All” (you will do this at two points during the DBAdmin process).  
When you click finish, you will have an empty database into which you can begin entering company 
and employee information.  You may need to enter an Activation Code to confirm your license.

If you have pointed DBAdmin to an existing database, you will select Next throughout the balance of 
the DBAdmin process.  If you receive any errors or are warned of database incompatibility, then you 
may not be pointing to the proper Common Directory location, or your database is of a different vesion 
than the program you have installed.  You will need to call us for further instructions if that occurs.

Upon completion of DBAdmin, you will be returned to the login screen.  You may hit Cancel to close 
this login window since you will still be in DBAdmin mode and will not need to launch that now that 
you have configured the program.

Launch the program from the shortcut on the desktop.  Log in with the User Name and Password 
provided to you by whomever administers the program for your company.  (New/blank database 
users can log in with Admin and no password to begin setting up the system.) 
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Continued on Next Page
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If you encounter an error trying to run the program (such as “Invalid Resource File” or “Cannot Update 
Cursor”), the following adjustments to User Access Control and/or Folder Permissions will need to be 
made:     [Please note that a network administrator or other IT person may need to participate in order to 
allow these changes or to fine-tune them to comply with your company’s security guidelines.]

Diamond requires that User Access Control (UAC) in Windows be set to “Never Notify” – this is done via 
Control Panel | User Accounts | Change User Account Control Settings. Drag the slider all the way down to 
the bottom, select OK, and then reboot the computer.

All users of the Diamond program on any particular computer will need Full Control at the application 
directory which would be C:\Program Files (x86)\SoftwareTech unless you changed the destination folder 
during the installation.  To set permissions, right-click on the SoftwareTech folder, select Properties, click 
on the Security tab – All Users should be given Full Control.

If you encounter an error during login (such as Invalid ODBC Connection or Invalid Path), then you may 
not have sufficient Network Privileges to access the shared database, or you may not have the correct 
path to the Common Directory specified.  Your company’s Network or System Admin should be able to 
resolve this for you.

If you encounter an error referencing missing dll files, Resource File Version Mismatch or Visual FoxPro 
Support Library, then you likely need to download the following and unzip it into your local 
Windows\SysWOW64 directory and/or where your Diamond Edition Software exe file is located: 
http://www.stisupport.net/support/VFPDLL.zip

Solutions to Common Problems 
During Installation or Launch

Remote Support is Available
We provide remote support via GoToAssist which allows us to connect to a computer at your location 
using an Internet connection.  Remote support sessions can be scheduled by calling the office at 
(540) 721-1000.  The computer to which we will connect must not only have Internet access, but also 
access to any shared network resources required (i.e. when the Common Directory is stored on a 
network server) as well as rights to allow the running of remote connection software.  What follows are 
directions for initiating a Remote Support Session with us.

Continued on Next Page
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Remote Support Continued
Please click on the following link to log in for remote assistance:

http://www.gotoassist.com/ph/softwaretech

The page displayed will look like this and you will need to fill in all three text boxes or you will generate an 
error. Please be sure we can identify you and your company by the names you choose.

Your Name:

Your Company Name: 

question 
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CCChhhaaapppttteeerrr   111   IIInnntttrrroooddduuuccctttiiiooonnn   

This Manual Covers 
• Installing HR and importing information from other database programs 

• Setting and maintaining organization information 

• Entering and maintaining employee data 

• Producing reports 

• Trouble shooting  

Installation and Setup 
For system requirements and installation instructions see Chapter 2 – Installation and Setup. 

Background Information 
To establish setting up and maintaining your system environment information, see Chapter 3 – Getting Started.  
To setup and maintain organization information see Chapter 4 - Establishing Organization Information. To add 
and maintain employee data see, Chapter 5 – Establishing Employee Information. 

Basic Operation 
To learn how to perform the most frequently used HR functions, see Chapters 6 – Tools.   

Reports 
To see common information general to all reports, see Chapter 7 – Reports. To review Employee Reports, see 
Chapter 8 - Employee Reports.  To review Organization Reports, see Chapter 9 - Organization Reports.  

Utilities  
To review HR Utilities, see Chapter 10 – Utilities. 

Trouble Shooting 
For fast help with common problems, see Chapter 11 – Trouble Shooting. 

A Windows Program 
HR runs under the Microsoft Windows Operating System.  This manual assumes that you know how to 
perform routine mouse and keyboard operations in this environment. 
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Conventions Used in this Manual 
In this manual, we put [square brackets] around keyboard keys you must press, such as function keys [F1], the 
[Tab] key, the [Enter] or [Return] keys.  Prompts (messages and HR displays on screen) are shown with this 
typeface.  Information you enter into data fields is shown with this typeface. 
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CCChhhaaapppttteeerrr   222   IIInnnssstttaaallllllaaatttiiiooonnn   aaannnddd   SSSeeetttuuuppp   
 

This chapter familiarizes you with the minimum and recommended system requirements necessary to run HR. 

The Installation Procedure is covered in detail.  It leads you through the basic install steps and then follows with 
advanced setup procedures.  If you have questions concerning the installation or setup, do not hesitate to call 
Software Techniques’ Customer Support at (540) 721-1002. 

System Requirements 
With your purchase of HR, your license defines a maximum number of employees.  Minimum system 
requirements are fine if you have 100 or fewer employees.  As the number of users and/or employees grow, 
processing speed slows and you may wish to increase processor speed and/or memory size to recommended 
levels. 

 

Resource Minimum Recommended 

Hard Drive 

(local and network) 

500 Megabytes (MB) 2 Gigabytes (GB) 

RAM 1 GB 2 GB or Higher 

Operating System Windows XP Windows XP / 7 

Database Server MS SQL Server 2005 MS SQL Server 2008 R2 

 

HR Installation Procedure 
1. Make sure that your system meets or exceeds the minimum HR System Requirements 

2. Insert the HR CD into the CD-ROM drive 

3. If your system has the Auto Run feature set on, skip to Step 6.  Otherwise, Click the 

Microsoft Windows  icon 
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4. Click Run and the following screen will appear 

 

Run Startup  

5. In the Run dialog Command Line box, type d:\startup.exe and click OK.  If your CD-ROM 
has a different letter than “d”, substitute that letter for “d”.  For example, e:\startup.exe.  
The following screen will appear. 

 

 

Startup for HR SQL Server Edition 
 

Startup for HR Diamond Edition 

6. You may now install HR.  Click Install HR SQL Server or HR Diamond. 

At this point, the following screen will appear. 
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Install Shield - step 1 

7. Click Next to continue.  The following screen will appear. 

 

Install Shield - step 2 

8. Enter Customer Information.  Click Next to continue and the following screen will appear. 
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Install Shield - step 3 

The above screen will allow you to change the destination folder.  The Destination Folder is 
the folder where the HR software will be installed.  Installing to the default folder is 
recommended. 

Note - The Destination Folder is where the software program is loaded.  This may be different than 
your Common Directory (discussed later in the Startup section of this chapter).  Also, the 
installation directory is not necessarily located on the same disk or computer where your SQL Data is 
located.  The software works best when installed directly on the client, to take full advantage of the 
nature of C/S architecture. 

9. After selecting an installation directory, click Next to continue the installation.  The following 
screen will appear. 

 

Install Shield - step 4 

If you have made a mistake, you may go back and correct it at this time. 

10. If you agree with the information stated, click Install to continue.  The following screen will 
appear. 
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Install Shield - install in progress 

Install Shield will keep you abreast of its progress. 

When the installation has been completed, the following screen will appear. 

 

Install Shield - install complete 
 

11. The installation is now complete.  Click Finish and you will be returned to the 
following screen. 
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Startup for HR SQL Server Edition 

12. You are now ready to run HR and setup your database connection. 

13. Click Close to continue. 

Database Connection and Setup – SQL Version 
 Only use this section if you are using the HR SQL Server Edition.  If you are using HR 

Diamond Edition, check out the next section, Database Connection and Setup – Diamond 
Version. 

1. Before you will be able to continue you will need to make sure that you work with your DBA to 
create an empty SQL database.  Make sure that the database is large enough to support all 
your data.  Also make sure your DBA has given you a SQL account with the necessary security 
to create all the tables that HR SQL will create. 

Write down the SQL Server Name for reference _________________________________ 

Write down the SQL Database Name for reference _______________________________ 

Write down or memorize your SQL account User Name ___________________________ 

Also memorize your SQL account password 

2. Next, work with your DBA to make sure you have a SQL connection from your client 
workstation.  The next few steps will help you complete the connection process.  However, 
you will not be successful unless you have the SQL client tools installed and you can connect 
to your SQL server via your network.  In other words, it will be probably be best if your DBA 
assists you in the next few steps. 

Most SQL environments will require the SQL DBA to perform some of the database installation 
steps. 

Use the Database Administrator Tool for HR SQL to establish the SQL database 
connection and setup the database tables.  From the Windows start menu: 



 Chapter 2 Installation and Setup - 15 
 

 

 

Selecting DB Admin mode from the Windows Start Menu 

3. After starting HR SQL, you will be asked to review the license agreement. 

Be sure to read through the entire License Agreement: 

 

License Agreement 

 
If you agree with the terms of the license agreement, click .  

If you do not agree, click .  Click OK to continue. 

4. If you clicked “I Accept” after installing HR SQL, the following login screen will appear. 
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DB Administrator Login 

At this juncture you will be unable to login.  The first thing you will need to do is configure 
your Common Directory and setup your ODBC Connection.  To do this click Configure.  If the 
button says "Change" rather than "Configure" then you are in the wrong place.  You need to 
be running the DB Admin Tool first before running the main application. 

5. The first thing you will need to do is establish a common directory.  HR SQL needs a common 
area to store common files that can be accessed by all users.  It is usually best to store this on a 
networked file server that is on the same network as your SQL database server. 

 

 

New Common Data 
 

Note to the Network Administrator - The common directory serves as a central gateway 
for the application.  It contains graphical images, user defined absence icons, encrypted 
email configuration files, and encrypted ODBC connection strings, and report templates 
as well as other common components shared by all users.  It is important for consistency 
that all users, who are accessing the same database, share the same Common Directory. 

 Select a common directory on a shared network drive or shared network resource, such as 
“T:\HRSQL Data\Common”. 

6. The next step is to connect to the SQL Server and create an ODBC connection. 
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Establish an ODBC Connection string 

 Enter the name of the SQL Server and the SQL Database that you recorded earlier.  You will need 
to supply a SQL server account id and password.  If you are not sure contact your SQL DBA.  You 
can test your connection by clicking Test Connection.  Once you have made a successful 
connection, click Next. 

 

7. At this point you will have the option of Checking for Updates on the Web. 

 

Check for Web updates 

This step is not always necessary, but is probably a good idea.  In some instances where there has 
been a change to the database structure, you may have to check for and download an update.  If 
there are updates available, they will be downloaded to the common directory.  Each workstation 
will update itself from the common directory.  Click Next to move on to the next step. 

8. After connecting to the SQL Database, HR SQL will automatically test the database for structural 
integrity.  If you have just installed the application, the database should be empty. 
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 To create a new database or to repair an existing database with a broken database structure click 
Fix All.  HR SQL will automatically construct all the missing database components.  Once you have 
a working database structure, click Next. 

9. The next step is to make sure that the data in the database is initialized for use.  At this juncture 
the data should be empty and will need to be created just like the database structure was created. 

 

 

 HR can easily create an empty database for you. 

To start from scratch with a blank database you can click Fix All. 
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Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click Finish and you can 
return to the Database Administrator Logon screen. 

 

 

Return to Database Administrator Login 

 With everything completely setup you will now be able to access HR from the icon on your desktop 
or from the Windows Start menu. 
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Database Connection and Setup – Diamond Version 
Only use this section if you are using the HR Diamond Edition.  If you are using HR SQL Server Edition, check 
out the previous section, Database Connection and Setup – SQL Version. 

 

1. The next few steps will help you help you complete the connection process. 

Use the Database Administrator Tool for HR to establish the database connection and setup 
the database tables.  From the Windows start menu, click Tools-Database-Administrator. 

 

 

Selecting DB Admin mode from the Windows Start Menu 

2. After starting HR, you will be asked to review the license agreement. 

Be sure to read through the entire License Agreement: 

 

 
If you agree with the terms of the license agreement, click .  If 

you do not agree, click .  Click OK to continue. 

3. If you clicked I Accept after installing HR, the following login screen will appear. 
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At this point you will be not be able to login.  The first thing you will need to do is configure your 
Common Directory.  To do this click on Configure.  If the button says "Change" instead of 
"Configure" then you are in the wrong place.  You need to be running the DB Admin Tool first 
before running the main application. 

4. The first thing you will need to do is establish a common directory.  HR needs a common area to 
store common files that can be accessed by all users.  This common directory will also be where 
your main database is stored.  It is usually best to store this on a networked file server. 

 

 

 Note to the Network Administrator - The common directory serves as a central gateway for the 
application.  It contains graphical images, user defined absence icons, encrypted email 
configuration files, encrypted ODBC connection strings, and report templates as well as other 
common components shared by all users.  It is important for consistency that all users who are 
accessing the same database share the same Common Directory. 

5. This step will show you where your database will be stored in relation to the common directory.  It 
also shows the type of database used.  Click Next to go to the next step. 
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6. At this point you will have the option of checking for updates on the Web. 

 

This step is not always necessary, but is probably a good idea.  In some instances where there has 
been a change to the database structure, you may have to check for and download an update.  If 
there are updates available, they will be downloaded to the common directory.  Each workstation 
will update itself from the common directory.  Click Next to move on to the next step. 

7. After connecting to the database, HR will automatically test the database for structural integrity.  If 
you have just installed the application, the database should be empty. 
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 To create a new database or to repair an existing database with a broken database structure click 
on Fix All.  HR will automatically construct all the missing database components.  Once you have a 
working database structure, click on Next. 

8. The next step is to make sure that the data in the database is initialized for use.  At this juncture 
the data should be empty and will need to be created just like the database structure was created. 

 

 

 HR can easily create an empty database for you.  To create a blank database you can click on Fix 
All. 



HR User Manual 24 
 

 

 

Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click on Finish and you 
can return to the Database Administrator Login screen. 

 

 
Return to Database Administrator Login 

 With everything completely setup you will now be able to access HR Diamond from the icon on your 
desktop or from the Windows Start menu. 
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License Activation 
1. Now you should be ready to run HR for the first time. 

 

 

SQL Edition and Diamond Edition icons are shown 

 

 

First time application login 

 To enter HR for the first time, login in as Admin with no password.  Once you get in you 
can change your User Name and Password. 

2. Now you should be ready to activate your license. 

 

 

Enter your activation code 

 Your CD and CD case should contain an Activation Code.  Simply enter the code and click 
OK and you are ready to use HR.  Once activated, your database will be locked into a 
maximum number of employees.  If your company exceeds that number of employees, you 
can contact your sales representative to purchase a license extension.  You will then receive 
a new activation code, which can be entered through the Upgrade License Utility. 

 Congratulations!  You are now ready to begin using HR. 
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Setting up additional workstations 
After the first workstation, each additional workstation is much easier to set up.  To set up additional 
workstations, you can enter the program normally (not in DB Admin mode).  Once in the program, you will get 
to a similar login screen: 

 

The Configure button has been replaced by the Change button.  In this case, click the Change button.  The 
following screen will come up: 

 

Just change the Common Directory field to what you set up in the step above.  Once you click OK, the 
workstation will inherit all the settings from the common directory.  Just click OK on the Login Screen and you’ll 
be in! 
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Now that you have installed HR, you will want to configure the software to your specifications.  There are 6 areas 
that you should configure to setup your environment and 1 that will help in review of your network: 

• Super Administrator Options 

• Workstation Options 

• E-mail Configuration 

• Startup Settings 

• Evaluation Scoring  

• User Codes 

• Net Watch  

Visit these sections in order for best results. 

System Roles 
In order to better understand which users have access to which options in HR, it is helpful to cover the 
following System Roles. 

Employee 
Employees have read-only access to their own information.  They can view their own records.   

Administrator 
The Administrator role is allowed to view and modify a certain subset of employees.  This can be for one or 
more departments.  The Super Administrator sets their privileges. 

The Administrator role does most of the data entry into the HR system.  They can access and modify all 
employees in their purview, but can not alter any global configuration settings.  

Super Administrator 
The Super Administrator has all privileges in the HR system.  They can do everything an Administrator can do 
as well as setting global configuration parameters and assigning Administrator roles and privileges.  The Super 
Administrator can also give users Super Administrator options.  

Super Administrators have access to all employees, all the time.  They also have access to all sections of the 
application.  Super Administrators can log in as regular administrators if they want.  If you log on as a Super 
Administrator, the database will be locked and you will be the only one allowed to use HR at that time. 
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Database Administrator 
The Database Administrator is a special role that works outside of the HR application.  This person is 
responsible for making sure that your Database is functioning properly.  This includes creating the SQL 
Database, making sure the SQL Server is operating smoothly, making sure the HR Database is secured and 
accessible by all those that need access, and finally making sure it is backed up on a routine schedule. 

 

Feature (see 
menu) 

Employee Admin SA 
(shared) 

SA (users 
locked out) 

Export  X X X 

Import    X 

Startup Settings    X 

Departments    X 

Email 
Configuration 

  X X 

Upgrade 
License 

   X 

Web Update    X 

Email 
Notification 

 X X X 

Employee 
Reports 

X X X X 

All Other 
Reports 

 X X X 

Security feature grid (X = access allowed) 
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Getting Around 
HR is a standard Microsoft Windows application.  You should be familiar with concepts such as menus, 
clicking, double-clicking, drag & drop and therefore have no problem learning your way around. 

 

 

 

The default screen of HR shows a list of Employees, Employee Categories and Employee Personal Information.  
Each of these categories has their own section in Chapter 5 – Employee Information.  There is also a 
Department drop-down list box so you can filter your list of employees by department. 

Depending on your role in HR, you will have access to some of the features.  The others will be disabled. 

HR operates by interfacing with the HR SQL Database.  This is handled internally by the application as it 
communicates with the SQL Server.  The SQL Server can maintain several databases.  To make sure you are 
accessing the correct database you can always look at the application title bar.  It should include the name of 
the database in square brackets (e.g. [hrsql]).  If the correct database does not appear in the title bar, exit the 
application and contact your Database Administrator. 
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Read Only Access and Record Locks 
As you select an employee, HR SQL will communicate with the SQL Server to get the records for that 
employee.  The first user to access a set of records will place a lock on the records for that employee.  When 
the second user attempts to access the same record(s) at the same time he will only be able to access the 
record(s) in Read-only mode.  This will prevent two users from changing the same record(s) at the same time.  
When a record is accessed in Read-only mode the screen title will display “[READ ONLY]” next to the employee 
name and the screen will be a darker shade of grey. 
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Super Administrator Options 
To enter this mode, click Settings->Super Administrator options.  This screen allows the Super 
Administrator to configure global settings that will apply across HR.  

 

Date Configuration 
This allows you to choose how you want the date to be displayed. You can choose from the options in the drop 
down window. 

Conversion Values 
This allows you to set how many hours per day, days per week, and weeks per year for your organization. 

Evaluation Scoring 
This allows you to set how the rating for employee evaluations will be displayed.  This will be defined later in 
this chapter. 

Data Suppression 
If you are a user of Software Techniques’ SoftTime or TimeKron, you will be able to display current information 
about the employee in HR.  HR will automatically enable data sharing between the programs.  If you want to 
suppress these features, click the suppress SoftTime and TimeKron information boxes.  For more information 
on integrating TimeKron, punch clocks, and other biometric devices and SoftTIME Diamond SQL Server Edition, 
with HR contact our sales department at (540) 721-1000. 
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History Options 
HR can automatically create work history for each employee.  There are nine different fields that can affect 
work history.  If you want to automatically create a work history record, when any of those fields change, just 
check the appropriate box.  If you do not want to do this, click Don’t auto-create work history records.  
Additionally, HR can auto-create address history records.  Any time you change a field on an employee’s 
current address, an address history record (with the old address) is recorded.  If you don’t want to track 
address history in this way, click Don’t auto-create address history records. 

Company Info 
This information allows you to customize reports and printouts with your company name and logo.  The name 
entered here will appear wherever a report or screen displays the company name. 

Pressing the Get Company Logo button will present you with a file picker dialog to choose an image file for 
your company logo.  Reports allow you to select a checkbox to display this logo on printouts. 

 

Workstation Options  
To enter this mode, click Settings->Workstation Options.  These options apply only for the specific 
workstation on which HR is running.  They govern certain settings that apply to the user’s session and display 
preferences. 

 

Low Resolution Printer 
This option allows you to specify that you have a lower resolution printer.  The report generator will forgo the 
fancier shading it uses when generating reports. 

Case Sensitive Password 
This applies to the passwords for THIS WORKSTATION ONLY.  If it is set then anyone logging into this machine 
will be required to enter a case sensitive password.  
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Tool Tips 
This option will present you with a tool tip on the cursor wherever one is available in HR.  This can be helpful 
when you are first learning the software and can be turned off after you are familiar with the program. 

Exit Warning 
This option will alert you any time HR is closing to make sure you actually wish to end your session. 

Deletion Warning 
This option will confirm deletion any time you attempt to delete anything in HR.  

Automatic Office Assistant 
This option will automatically perform Office Assistant checks on startup as directed in the Office Assistant form. 

Automatic Phone Formatting 
This option will automatically format the phone number. (e.g. (XXX) XXX-XXXX). 
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E-mail Configuration 
To enter this mode, click Settings->E-mail Configuration.  These settings are available to the Super 
Administrator ONLY.  They basically configure HR to generate email via your existing e-mail server. 

 

Enable E-mail Notification  
This is the first step to setting up your e-mail configuration.  When this box is checked all of the other settings 
become enabled.  Without e-mail notification enabled HR will not attempt to generate e-mails. 

Auto-detect Settings Button 
This handy button will go out onto the Super Administrator’s computer and detect the server and account that 
is set up in the default mail client.  It will present you with a confirmation dialog showing what it was able to 
detect.  This tool may not work for all computers, but it’s a good place to start. 

Auto-detect Settings 
You can either accept the detected settings by clicking OK or ignore them by clicking Cancel. 

Outgoing Mail Server 
This is the SMTP server name that handles your outgoing mail.  It can be found in the configuration settings of 
your mail program.  It is usually in the form “mail.yourcompany.com” or “smtp.yourcompany.com”. 
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Administrator E-mail 
This is the e-mail address HR will use to generate e-mails.  It must be a valid account on the specified mail 
server above.  This is also the account that will be notified if there is a problem sending e-mails. 

Administrator Name 
This is the name associated with the e-mail account above.  It will be filled in by the Auto-Detect or you can 
change it so the generated emails appear as if they come from a certain person in your organization. 

E-Mail Protocol 
Most HR users should be able to use their e-mail server with the default protocol.  This is an internal HR 
protocol known as “Protocol S”.  In some rare instances, you may experience problems with your e-mail server 
settings.  In these situations a certified Technical Support Engineer may suggest that you try using the alternate 
protocol “Protocol W”. 

My Server Requires Authentication 
With security as a concern these days, most mail servers require authentication.  However, since this will be 
internal mail to employees, your mail server may not require it.  If you use Auto-Detect, it will be able to figure 
out your server’s policy.  If authentication IS required, you must fill in the User Name and Password fields 
below. 

User Name 
This is your E-Mail User Name, not to be confused with you HR login.  In some cases it is your full email 
address.  Auto-Detect will be able to figure out if your server requires the full address or just your information 
before the “@” sign. 

Password/Confirm 
This is your E-MAIL password.  You must enter it here twice.  Auto-Detect Will NOT fill in your password. 

Test E-mail 
Once all the information has been entered, you can test to see if the information will work.  Click the Test E-mail 
button in the upper right corner.  If the E-mail was sent successfully you will be notified.  Otherwise, it will tell 
you why the e-mail did not send.  If the E-mail did send, go to your E-mail program and receive mail from the 
Administrator E-mail account.  If you receive the email, you are all set. 

Default E-mail Subject 
This is the text that will appear as the default subject for generated e-mail.  You can override this subject on 
the e-mail notification screen. 
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Evaluation Scoring 
To enter this mode, click Settings->Evaluation Scoring.   

This screen lets you set ranges for HR to express evaluation scores.  Scoring Codes are based on the 
percentage of points earned, not the point total.  For example, using the values in Figure 3-5, HR would 
convert a score of 97 out of a possible 100 to A (97%).  The first or best score will always end with 100 and the 
last or worst score will always begin with a 0 or 1.  You can define up to 10 scoring codes for your company.  
When you add or change a score’s from value, HR will automatically adjust the scores to the value. 

 

 

To add a new value, simply click the last record and change the From score to a value greater than 0.  A new 
rating will appear with the name “-New Scoring Code-“. To change the name of the new score, click the box 
containing “_New Scoring Code-” and enter the new name. To remove a scoring code, change the From value 
of the preceding scoring code to match that of the code you want to remove. HR will merge the two codes, 
keeping the name of the higher scoring code.  (i.e. To eliminate the “H” category, change the value of G from 
30 to 0.)  If you wish to remove all of the scoring codes, click the Clear Scores Button. 

Evaluation Scoring’s default is Numeric. If you choose an Alternate scoring code, it can be changed in the Super 
Administrator options located on the Settings taskbar. 
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User Codes 
To enter this mode, click Settings->User Codes.  User codes allow you to create or modify items of various 
user code categories.  

 

To change the User Code Category, click the Code Category drop down box.  This will list all of the categories 
available for modification.  Select the category you want to adjust.  A list of available items for that category will 
appear.  You can add, delete, or modify most of these items.  A few items are fixed and can not be modified or 
removed.  To modify an item, select it and edit the name in the text box.  You can not remove an item if it is in 
use.   

NOTE:  Changing a title is a System Wide modification.  When you modify an existing title, that title 
will be changed throughout HR, including each employee file. 

Netwatch 
To enter this mode, click Settings->Netwatch. This screen shows all users currently logged in to the system, 
their workstation ID, and the application.  Clicking on the refresh button will update the screen and show any 
changes since you last opened the screen. 
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Defining the organization is the first task that must be completed after the software installation and before 
you can enter any employee information into the system.  In this chapter, we will explore what is needed to 
get started. 

Departments 
Entering Department information is the first item you need to complete.  This information defines your 
organization, and affects all employees and reporting; any changes you make in this category changes the 
entire organization. Click Organization.  This section is broken down into Departments, Positions, Company 
Benefits, Evaluations, and Attachments.   

Before employees can be added to HR, it is recommended that you set up your departments and positions. 

Adding Departments 
Click Organization -> Departments and select the Add Dept button.  A new screen will appear with the 
department area blank.  The only mandatory information on the screen is the department name. Click Add 
Dept to enter additional departments.  You can also add a manager, assistant, and department description by 
clicking inside the Description field box and typing the information. After you have completed adding all the 
departments, click the OK button. 

 
 

Note - If you modify the department name, any employees assigned to that department will also have 
their department name changed.   
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Removing a Department 
Click Organization -> Departments.  Find and select the department you want to remove and, click the 
Remove Dept button.  You can only remove a department if the headcount is zero (0). 

Positions 
Entering Positions is the second item you need to do before you can add employees.   This information 
defines your positions, the minimum, mid-point and maximum compensation, Pay Rate, Exempt and EEO 
Category. 

Adding Positions 
Click Organization -> Positions and click the Add Position button.  The Position Name field will be 
highlighted with New Position.  In the Position Name enter the position; press the [tab key] to take you to the 
next field.  This will select the Job Description field.  The job description field is not a mandatory field but is 
helpful when writing up job descriptions for advertising.   Enter the Job Description and press the [tab key] to 
take you to the Min field.  Type the compensation information in each field.  These values serve only as 
guidelines.  An employee’s salary can go below the minimum or above the maximum. Tab to the Pay Rate 
field, from the drop down menu, pick the type of Pay Rate, Hourly, Daily, Weekly, Bi Weekly, Monthly or 
Annually.  If the position is an Exempt position, click Exempt.  From the drop down menu, select the 
appropriate EEO Category.  Now tab to the Pay Description field and enter how often this position is paid or 
other information about the Pay.  To add more Positions click Add Position and repeat the process, when 
finished click OK.  
 

 

Removing a Position 
Click Organization ->Positions.  Find and select the position you want to remove and click the Remove 
button.  You can only remove a position if the position is not being referenced in an employee record. 
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Company Benefits 
Entering Company Benefits must be done before you can add them to employee files.  In each benefit 
record you can determine when employees will become eligible for the benefit and how long after an 
employee terminates the benefit is available to them. 

Adding Company Benefits 
Click Organization ->Company Benefits.  Click Add Benefit and the field will be highlighted with New 
Benefit.  In the Benefit Name field, enter the benefit, press the [tab key] to take you to the Eligible After field.  
Enter when this benefit is available to the employee.  For example: 401K coverage - if this benefit is available 
after 6 months and continues for 0 months after termination enter the following:  In the Eligible After field you 
would enter 6, [tab] to the next field and select months from the drop down menu or type “m” for months. 
[tab] to the Continues after termination for field and enter 0, [tab] to the next field and select months from 
the drop down menu or type “m” for months.  Now [tab] to the Benefit Description area and enter 
information that describes the Benefit.  The Benefits Description field is not a mandatory field. 
 

 

 

Note - HR benefits do not make a distinction between full and part time employees.  Eligibility is 
based on the employee hire date.  
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Evaluations  
Entering Evaluations must be done before you can enter an employee evaluation. 

Adding Evaluation Types and Categories 
Click Organization -> Evaluations.  The Monitor Evaluations screen is separated into two sections.  
Evaluation Type and Evaluation Categories. 
 
To create a new Evaluation Type, click Add.  The Add Evaluation screen will appear (figure 4-4). Type the 
name of the evaluation in the text box and click OK. 
 

 

Add Evaluation Screen  

 
 
 

To make a change to the evaluation name, click the Edit button on the Monitor Evaluations screen (figure 4-
4).  

To add evaluation categories to an evaluation type, select the descriptor and click , when completed 
selecting descriptors, click OK.  For each category that you add to an evaluation, you can adjust the point 
total for each category.  To do this, click the category in the list on the left.  Underneath the list, the category 
will appear.  Then just click the field next to it and enter a value for that category.  Keep in mind that 
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categories can have different values in different evaluations.  Once you’ve entered a value for the category, 
you’ll see it appear to the right of the category in the list on the left. 

To add Evaluation Categories, click Modify Evaluation Categories and then click Add. 

In the Category Name field, type your evaluation category. Continue to click Add until you have all the 
category names added. When finished click OK.  To remove an Evaluation Category, select the Category, 
click Remove.  

 
 

Note: If you try to remove a category name and it is in use, you must remove all references to the 
category, before it can be deleted. 
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Attachments 
Attachments are important documents you would like to store and refer to for future reference.  They can be 
word processing documents, excel spreadsheets, photos, audio or video files, and other graphic images etc.  
To add an attachment, click Organization->Attachments and enter the required information for the 

attachment and select the . Locate the document and click Save.  HR saves the location of the document.  
To access the document, select the document from the white box and double click.  The attachment or 
document will be retrieved by the program that was used to create the attachment.   

 

 

 

It should be noted that HR will allow multiple attachments for each category for each employee. This is a 
powerful feature.  To read more on this feature, see Chapter 5 - Employee Information. 

Note: HR will not move each attachment you enter to the Common Directory.  It will simply save the 
location that you specified.  The reason for this is that if changes are made to any file that HR links to, 
we didn’t want the user to have to make changes twice (once for the original, once for the copied 
version).  Because of this, it is important to note where each file is.  If you specify a file on your local 
hard drive, users on other workstations will not be able to access the attachment.  Keep this in mind 
when specifying attachments. 
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Employee Data 
The Employee Data screen allows you to Add, Edit and Remove employees from the system and allows 
access to all employee information categories.  Each category is explained later in the chapter.   

To review employee data by department, click the department box in the top left corner of the screen. 
Choose the department you want to view.  All employees in the selected department will appear in the 
employee list box (Figure 5-1) directly underneath the department box. (Selecting All Departments will show 
all employees in all departments.)   To select an employee, click the employee name in the employee list box.  
Once you have selected an employee, you can choose one of the categories on the right side of the employee 
name box.  Depending on the information to be viewed, move to the desired category and left click the 
mouse.   The employees’ data will be displayed.  

Add an Employee 
To add an employee, click the Add button under the name box. 

Note – Before you add employees, it is recommended that your organization data such as 
Departments be set up.  To set up your organization information see Chapter 4 – Setting up 
Organization Information. 

 

 
Enter employee data on the Add Employee Screen. The only required data to be entered is Last Name. The 
system assumes the hire date is the current system date.  If the hire date is something other than the current 
system date it can be overridden by selecting and entering the correct hire date. You can enter basic 
employee information only on this screen.  After completing the information for a new employee you can add 
another employee by clicking Add Another. Once you have finished, click OK. 
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Note – Additional information about an employee is added through the 14 categories located on the 
employee data screen (Figure 5-1).   

 

Edit Employee Data 
To maintain an employee's personal information, click the Edit button or double click personal.  

The following screen will appear: 

 
At this point you can edit basic employee information.  Address and Address History information has its own 
screen (see Address History). 
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You can make multiple attachments about an employee from this screen. 

 

 

Category Attachments have their own screens. 

An employee photo may be attached from this screen. Click Find to attach a photo or click Remove to un-
attach the photo from the employee record. 

 
Since Employee Numbers, Badge Numbers and Payroll Numbers may differ for each employee, we have 
provided you a method of maintaining each.   

 
The Employee's E-mail is a very useful field because HR will allow you to send any report to an employee or 
employees at will (Reports). This is a powerful feature used to notify an employee of a change in their 
recorded employee history, attendance history or work history. We also find this feature useful to send a 
manager a Department Level Report. Of course in order to use this feature you must provide an E-mail 
address for each employee you wish to notify. You may do this here: 
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Security 
 

The Security options allow the Super Administrator to grant Administrator privileges to users managing 
departments and to assign which departments they have access to.  The Super Administrator can also grant 
Super Administrator access to another user. 

Administrators and Super Administrators can also change a User's Name and Password.  Employees can 
only view their own security setting that by definition is only Employee Access. 

To change a Security setting for an employee, click one of the radio boxes 

• Employee Access 

• Administrator Access 

• Super Administrator Access 

 

 

 
and then by activating a check box, you will activate that option. To turn off an option click the appropriate 
checkbox. The following screen shows that this employee may access their own information. 
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Notice that an administrator can be assigned to more then one department without being assigned to all 
departments. The following screen shows that this administrator may access two different departments. 

 
 

Also the administrator's privileges can be set at one of three levels.  Clicking on an empty check box will give 
a blue checkmark, which grants the maximum level of access including the ability to receive leave request 
emails.  If you click on the blue checkmark it will change to the green check mark.  This second level grants 
full read and write access, but the user will not be notified by email of leave requests.  Clicking a third time will 
change the checkmark to yellow which grants access only to view employee absence data for that 
department,  

 
but no access is given to add or change data.  If you click a fourth time the checkmark will be removed and 
the administrator will not have any access to that department. 
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Removing Employee 
If you find it necessary to remove an employee from the database, first make sure that the employee you 
want to delete is the currently selected employee in the employee list box (Figure 5-1). 

Note - Before doing this, it is a good idea to print all employee reports for that employee to be kept in 
the employee’s permanent file.  The reason for this is that once an employee is deleted from HR, all 
data for the employee is permanently deleted. 

Once you have selected the employee, click the Remove Button in the lower left corner of the screen.  A 
confirmation window will appear asking if you are sure you want to remove the employee.   
 

 

 

Individual Attachments 
HR allows you to enter attachments for each employee.  This is covered more in the Attachments section later 
in this chapter.  Another feature of HR is to add attachments for each category within an employee’s record.  
For example, you can add attachments to the Personal section or to a specific Warning.  In each case, each 
category’s sub screen will have an attachment section on the form. 

 

This list specifies the attachments related to that particular category for that employee.  For the Personal, Other 
and Emergency section, the attachments are attached to the whole form.  For the other areas (warnings, 
evaluations, etc), attachments are added to each individual record.  For example, if you attach a particular file 
to a specific evaluation, the other evaluations will not have that attachment.  Adding attachments to each 
section is quite simple.  Just click the Add button and you will see something like the following screen: 
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Just fill in the information including file location and click OK.  You will then see it added to the list. 

 

Clicking on Edit will take you to the same form where you can edit the information. 

 

Address 
The Address category stores present and past address information for an employee.  The information 
presented on the screen is the current information on the employee.  The information in the white grid shows 
the last time information was changed. 
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To add, edit, remove or print Address Information, select the action you wish to take at the bottom right of 
the screen. When you add or edit data, you will see the following screen: 
 

 

Add/Edit Address Screen 

 

 

Each employee has a current address.  When you edit the current address, you may be creating an address 
history record, depending on how that option is set up in Super Administrator Options.  When you edit a 
history record (any record but the “current” address), no new records are created. 
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Attachments 
HR allows you to electronically store documentation and other files received from the employee.  The 
attachments category lets you see all the documentation and where it its stored.  There are two places that 
attachments can be added, edited, removed or printed, at the individual category level or through the 
attachment screen directly.  To review an attachment, select the attachment in the white box and double 
click.  

 

 

To add, edit, remove, or print attachment information select the action to be taken at the bottom right of the 
screen. A new screen will appear, enter the data and click OK.  

 
 

Attachments Entry Screen 
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When viewing the main list of attachments for an employee, you will see all attachments from all categories.  
When adding an attachment through the main attachment section, you can choose the category it belongs to.  
However, it won’t be attached to any specific sub-section unless you add it through that section. 

Note:  Attachments can be any type of file, word processing, spreadsheet, picture, etc.  To view the 
attachment, double click the attachment and it will open in the appropriate application. 
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Awards 
The awards category allows you to document awards and other honors an employee has received. The 
information on the screen shows the last award added to the database.  The information in the white grid 
shows all awards received by the employee. 

 

 

To add, edit, remove, review or print award information highlight Award and select the action to be taken at 
the right hand bottom of the screen. A new screen will appear. Enter the data and click OK. 

Awards Entry Screen 

 

 

Note:  You can attach a copy of the employee’s Award. If it is a certificate, letter or any other piece of 
documentation, you can scan it on to your computer and add it to HR, eliminating paper that must be 
stored. 
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Benefits 
Companies offer many benefits from dental and medical, to 401K retirement plans.  To assign a benefit to an 
employee, you must first define the benefit in the Organization Benefit Screen. 

 

To select a benefit from the Organization Benefits and add it to the employee’s current benefits, click Add. 
To review a benefit, select the benefit in the white box and double click. 

From the list of Benefits, select the benefits to be added to the employee and select Add. 
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Benefit Entry Screen 
Once you’ve added or edited a benefit, you will see the following screen. 

 

The Date Eligible can be modified by clicking in the date field.  Benefits for each employee can have three 
statuses:  Not yet started, Started, Stopped.  The form will tell you what the current benefit’s status is.  The 
button to the left directly underneath the benefit’s status will show you what action you can take for the 
current benefit, which usually means starting or stopping it.   

 To review the history on the benefit or stop the benefit click Benefit History. 
 

 

The benefit history screen shows a history of when you’ve started or stopped the benefit for the employee.  
On the Benefit History screen you can enter a Stop Date, Reason Stopped and make Notes. When you enter 
an End Date or Reason Stopped, the date enrolled will disappear on the Benefits screen.     
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Certifications 
HR allows you to track employee certifications along with certification number and expiration date.   

 

To add a certification click Add, enter the information on the add screen and click OK. 

Certifications Entry Screen 
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Dependents 
HR allows you to keep track of an employee’s dependents.  You can specify the relationship of the dependent 
to the employee, the dependent type (i.e. children, spouse, and parents) and additional notes and 
attachments.  

 

To add dependents, click Add and enter the dependent information. 

Dependents Entry Screen 

 

Figure 5-17 
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Education 
HR allows you to keep track of your employee’s formal education.  You can enter information for several 
types of schools (elementary, high school, college, and graduate) and add diplomas through the attachments 
screen. 

 

To add education, click Add and enter education information. 

Education Entry Screen 

 

 

Note: HR pre-defines the Level available.  You can not add, modify, or delete a Level. 
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Emergency 
HR allows you to store emergency information for an employee in case of employee accident or other crisis.  
You may enter up to two (2) people to contact.  You can also record additional emergency information for an 
employee such as doctor, medical conditions or any other pertinent information as well as attachments.  

 

Emergency Entry Screen 
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Evaluations 
Employee evaluations can be a powerful tool to motivate and manage your employees.  HR allows you to 
design and record your own evaluations. 

 

To add an evaluation for an employee, click the Add button. 

The Select Evaluation window will appear. Select the evaluation you want to add from the Evaluation Type 
and click OK. 

 

After you select an Evaluation Type, HR will launch the Main evaluation screen. (Figure 5-24). For each 
category, you can enter comments and assign a score between 0 and the maximum score.  After completing 
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the evaluation you can see the overall score, its percentage of the maximum and verbal score. The verbal 
score is determined by the percentage and defined in organization defaults.  You can record evaluator and 
employee comments and add a copy of the review in the Attachments area. 
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Other 
This category tracks miscellaneous employee details.  Miscellaneous fields include spousal information, EEO 
Codes, Disability, Military Status, Work Permit Number, Union, I-9 and user defined fields. 

 

Figure 5-25 

 

Other Entry Screen 
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Training 
Training information is similar to formal education but contains information about job related studies.  You 
can track information on training, date attended, instructor, grades, notes and attachments. 

 

Figure 5-26  

To add a training class, click Add. 
Training Entry Screen 

 
Figure 5-27 

Note:  If there is a training class that you wish to enter for multiple employees, check out the Group 
Data Entry section in Chapter 6 - Tools. 

Note:  Training information certificate of completion can be added to the HR system by scanning the 
documentation and attaching it to the employee’s file 
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Warning 
Warning information defines the type of warning (usually verbal or written), who issued the warning, and other 
details about the warning. 

 

Figure 5-28 
To add a warning to the database, click Add. 
 

Warning Entry Screen 

 

Figure 5-29 
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Work History 
Work information contains primary employment data for the employee.  The screen displays Department, 
Title, Position, Job Status, Reason, Hire Date, Termination Date, Compensation, Supervisor, Job Description, 
and Attachments.  The current Work Information section contains the employee’s present work record.  Past 
work records can be selected by double clicking on the event in the white box. 

 

Figure 5-30 
To add a new record, click Add. 
 

Work Entry Screen (Current) 

 

Figure 5-31 
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Work Entry Screen (History) 

 
When editing the current work history record, a work history record may be added depending on the Work 
History settings in the Super Administrator Options.  Notice that the current Work Record (Figure 5-31) has 
drop down list boxes that allow you to select departments, positions, etc.  The history Work Record does not.  
The history record has free form text fields where you can enter information. 
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SoftTime 
HR interfaces with our SoftTime Attendance Control System.  Here you can view the selected employee’s 
current FYI absence information, just as you would see it in SoftTime. 

 

Figure 5-32 

TimeKron 
HR also interfaces with our TimeKron Complete Timekeeping System.  Here, you can view punch data for the 
employee for the current work week. 

 

Figure 5-33 
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HR has three tools to help you stay organized.  Checklists allow you to print a list of tasks that must be 
completed for a specific event, such as hiring a new employee; Office Assistant which helps you maintain 
complete data by telling you what employee data is missing; and Group Data Entry which allows you to enter 
data for multiple employees at one time, such as Training.   

Checklists 
Checklists assist you in office management by creating a list of items that need to be completed for a 
particular event.  For example, you may want to generate a checklist for everything that is needed for a new 
hire to complete or have on their first day of employment.  

To create a checklist, click Tools->Checklists on the taskbar. The Checklist screen will appear (Figure 6-1).   

 

Figure 6-1 

Click Add to the right of the drop down box.  In the Add Checklist box (Figure 6-2) enter the name of the 
checklist, such as “Volunteer Award Checklist”, Click OK.  
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Figure 6-2 

To select a checklist, click the List Name in the drop down box and select the desired list.  You can edit the 
name of a Checklist by clicking the Edit button.  To remove a Checklist, click the Remove Task button to 
the right of the drop down box. 

To add tasks to a Checklist, click Add Task.  Your task will appear in the box under task. To change the order 
of a task, click the order box next to the task, hold the left mouse button down and drag it to another position 
in the list. To remove a Checklist task, select the task from the list and click the Remove Task button. 

Office Assistant 
The Office Assistant checks your employee and department information for specific items and informs you of 
possible errors.  You can instruct the Office Assistant to check for missing information or other anomalous data 
patterns.  To run Office Assistant, click Tools-> Office Assistant on the toolbar.  

 

Figure 6-3 

Note:  To access the Office Assistant you must have security access to All Departments and edit 
access to personal information. 



 Chapter 6 Tools - 73 
 
The Office Assistant will only check the information that is checked in the left box (Figure 6-3) such as 
addresses, personal, etc.  To select the category to be checked by the Office Assistant, click the category, and 
click the items listed in the “Check for missing information” that are to be checked.  To remove an item, 
uncheck the item you want to remove.  Selecting a category will cause the Automatic Office Assistant to display 
the items in that category.  There are 19 categories that the Automatic Office Assistant can check for you.  Each 
one of these categories has several items.  You must select an item to have it checked.   

Running and Checking Your Data  
 
There are two modes for selecting data, Regular mode and Schedule mode.  You can create a separate list 
for each mode.  Regular mode can be run at anytime by selecting the information you would like to check 
and clicking “Do It”.  Schedule mode is run on a set schedule defined by you.  To set up the schedule, click 
Schedule and check the “Enable Office Assistant on startup. Determine how often you would like to run Office 
Assistant and enter a period (in days) in the “Check every X days box. Where “X” indicates the number of 
days between runs, such as 7 would run the check every 7 days or once a week.  The Automatic Office 
Assistant will display the date of the next scheduled check and will also display the last date the Office 
Assistant performed a scheduled check.  Scheduled checks occur at start up on the day they are scheduled. It 
will also display the last date a scheduled check was performed.  

 
 

Office Assistant Categories 
Below is a list of the Office Assistant categories and the items in that category you can select to check for 
missing information.  You can check both organization and employee information. The items are listed in 
italics after the category heading. 

Organization Categories 

Company Benefits  
Eligibility Information, Continuation Information, Details 

Departments 
Manager, Assistant, Details 

Evaluations Categories 
Category Name, Description 

Positions 
Position Name, Min Rate, Mid, Rate, Max Rate, Pay Rate Description 

User Defined 
Parking Space, UDef #2, UDef #3, UDef #4, UDef #5, UDef #6, UDef#7, UDef #8 
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Employee Categories 

Address 
Street Address, City, State, Zip 
 
If you want The Automatic Office Assistant to check the current employee address only, be sure to 
select the “check current address only” box 

Attachments 
Title, Date Entered, Comments 

Awards 
Authorized by, Summary 

Benefits 
The Office Assistant will check for benefit eligibility provided that the ”check for benefit eligibility 
option” is checked.  All of your company benefits are listed in the benefits box.  Select the benefit(s) 
that you want the Office Assistant to verify.  You can check when an employee will be eligible for 
benefits (Now, 30 days, 60 days, or 90 days).  You can have HR check benefit information that must 
be stopped for terminated employees.   

Certifications 
Expiration Date, Certification Number 
 
The Office Assistant will check for certification expiration and missing certification information.  Select 
the “check for certification expiration” option.  This will enable you to select your company’s 
certifications from the certification list.  You can have blank expiration dates be equivalent to expired 
dates.  You can also check when a certification will expire (Now, 30 days, 60 days, 90 days). 

Dependents 
Date of Birth, Relationship, Dependent Note 

Education 
Date To, School, Location, Date Graduated, GPA, Honors, Degree, Major 

Emergency 
Notification 1, Address 1, Phone 1, Relationship 1, Notification 2, Address 2, Phone 2, Relationship 2, 
Doctor, Doctor Phone 

Evaluations 
Evaluation Date, Evaluation Type, Evaluator 
 
The Office Assistant will check when your employees were last evaluated.  Select “Check for 
employees who were last evaluated”, option.  You can check when an employee was last evaluated 
by clicking (30 days ago, 60 days ago, 90 days ago, 3 months ago, 6 months ago, 9 months ago, 1 
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year ago or give HR the number of days).   You also check for employees who have never been 
evaluated. 

Other 
EEO, Disability, Military Status, Work Permit Number, Work Permit Expiration, I-9 Prepared, Union 
Name, Union Number, Martial Status, Former Name, Marriage Date, Spouse’s Name, Spouse’s SSN, 
Spouse’s Date of Birth 
 
The Office Assistant will check for work permit expiration.  Select “Check for employees who have 
work permits expiring” option.  You can have blank expiration dates be equivalent to expired dates.  
You can also check when a work permit will expire (Now, 30 days, 60 days, 90 days). 

Personal 
First, Last, Middle Name, Date of Birth, Social Security Number, Phone #1, Phone #2, Phone #3, E-
Mail, Sex, Hire Date, Payroll Number 

Training 
End Date, Location, Instructor, Grade 

Warnings 
Warning Type, Issued by 

Work 
Department, Title, Position, Job Status, Compensation, Reason Changed, Supervisor, Location 
 
The Office Assist will check work history records automatically; if you do not want work history 
checked deselect the “Check work history records” option. 

Completing Tasks 
 
Once you’ve chosen the areas you want HR to check, click the Do It button to perform the check.  If any area 
returns unfinished tasks they will appear in the following screen: 

 
 
To perform a task, click the task you want to perform and you will be taken directly to screen to complete that 
task. 
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Group Data Entry 
Group Data Entry allows you to add information to multiple employees at one time, such as Training. To use 
Group Data Entry, click Tools-> Group Data Entry.  

 

 

Figure 6-4 

HR allows you to select a group of employees, departments (Figure 6-4) or use advanced selection criteria 
(see Chapter 7-Reports).  Once you’ve selected a group of employees, select the category that you want and 
then fill out the corresponding information below.  You don’t necessarily have to fill out every field.  Once 
you’ve got all the information entered, click Add. 
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HR allows you to preview and print over 70 reports in twelve different categories.  Reports range from 
individual work history to department headcount.  Each report has different options.  This chapter explains 
common report features to all reports. 

To access the reports, click Reports->Employee or Organization Reports on the toolbar.  Select the 
category of the report you want to view from the drop down list box.  Each report available for that specific 
category will appear.   

Common Report Features 

 

Figure 7-1 

 

 

Figure 7-2 

The following information will be seen in most reports. 

Report Title 
The name of the report will appear in the report title box.  Each report comes with an assigned name, but it 
can be changed.  Below the Report Title is the report description giving a brief description of the report. 
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Date Range 

 

You can choose a date range for your report by specifying a from and to date. By default, the report will use 
all dates. By right clicking on any date, the Mini Calendar will appear allowing you to select a date. 

 

 

Administrator Title Lock 
When a Report Title is changed, it is changed for the entire system.  To lock down the report title, click the 
Administrator Title Lock.  Only an administrator can change that report title.  Administrator lock can be set for 
each report. 

Low Resolution Printers 
Low Resolution Reports allows for printing faster.  However, graphic images will not print in this mode.  Some 
printers do not have enough memory to print HR reports properly.  If you that a problem, try printing in low 
resolution mode. 

Company Logo in Header 
In the Super Administrator Options form, you can specify a Company Logo to appear in reports.  If you have 
a company logo specified, check this box for the logo to appear on reports.  

Company Name In Title 
In the Super Administrator Option form, you can specify a Company Name to appear in reports. If you want 
the company name to appear in the report, check this box. 

Print Button 
This button will print the current report. 
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Preview 
This button will allow you to Preview the report before printing, emailing or creating an HTML document. In 
the Preview mode, a Report Preview Toolbar will appear on the screen  

 

Figure 7-3 

The Report Preview Toolbar allows you to select any portion of the report you want to view.  With the Report 
Preview Toolbar you can: 

• Move to the first or last page of the report 

• Move to the previous or next page of the report 

• Move to a specific page in the report 

• View one, two or four pages at a time 

• Zoom in or out of the report 

• Print the report 

• Close the Preview window 

E-mail 
This button will allow you to e-mail the report to an employee or manager.  After clicking on the E-mail 
button the follow screen will appear: 

 

Figure 7-4 

The report’s title is in the upper left part of the form.  If you want to see the e-mail that will be sent, you can 
click the Preview button.  In the lower left part of the form, you can enter the e-mail subject and any additional 
text you want to include.   
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The list on the right is a list of employees and their e-mail addresses, if they have one.  To add an employee 
to the recipient list, double click the employee or click the recipient and click the Add button.  If you want to 
include a recipient that is not in the list, click the “Add Other Recipient”, which is located above the Recipient 
List.  A window will appear. Enter the e-mail address of the recipient and click OK. If you want to send an 
email to all employees within a department, click Departments, and select the department(s). Only 
employees with e-mail addresses will receive the report. 

Once you have selected one or more recipients, the Send E-Mail button will become enabled.  When you 
have selected all the recipients, click this button and it will start sending the E-mails.  The Send Log section in 
the lower right will display the sending progress. 

HTML 
This button will allow you to create and save an HTML document.  When the Save Window appears, give the 
HTML document a name and click Save. 

Dates 
Some reports lets you specify a date range to include in the report.  You can also select All Dates or a specific 
date. 

Selection Criteria 
Many reports allow you to specify which category of employees the report should include or exclude. 

 

The selection criteria section has both a simple and an advanced mode.  The simple mode is similar to what 
you would see in SoftTime or TimeKron.  The simple mode will look like this on the left side. 



 Chapter 7 Reports- 81 
 

 

Here you choose one or more departments or employees. 

If you want more advanced options such as limiting based on Job Status or Position, choose the advanced 
mode. 

 

The current selection criteria are shown in the box to the left.  To change the criteria, click the Select 
Criteria button. 
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Here you can pare down employee lists in 20 different categories.  Just select the category, and the list on 
the right will have the possible options you can check for.  Additionally, you can choose Hire Date or Birth 
Date and specify a date range for those.  Each time you adjust the criteria, it will be adjusted in the box. 

Also note that you can save and load criteria files.  If you want to print reports for Full Time employees in the 
Administration Department, you can save these settings through this form, and then load them up on a 
moment’s notice.  This way, you don’t have to redefine your selections.  Also note that criteria files can be 
loaded from the main criteria section on the report form itself. 

When you are finished selecting your criteria, click OK to return to the main report form.  The criteria you 
have just selected should now be in the box on the left. 

 

NOTE: Selecting none is the same as selecting all.  There are no comparisons to be made so all 
employees will be available.   

 

Multiple Fields for Reporting 
Some reports allow you to print data for more than one item (e.g. Benefits Used by Each Employee).  To 
select more than one item, hold down the Control Key on your keyboard while selecting the items you want 
to show on the report.  



 Chapter 7 Reports- 83 
 

 

Figure 7-6 

Terminated Employees 
Many of the HR reports automatically exclude terminated employees. If you want to exclude terminated 
employees from a report that includes them, click the Selection Criteria button (if available) and deselect 
terminated employees from Job Status.  For a complete list of which reports include Terminated employee 
information, see Appendix A-Reports. 

No Data Available for Printing 
If you receive this message when generating a report, then you do not have any data that matches the 
report criteria.  (e.g. If you preview a Birthday report for July and you do not have any employees with a July 
birthday, then you will receive this message.) 

Quick List Report 
HR offers an easy to use report writer called Quick List.  You can define up to eight categories for the report.  
You can access Quick List from Employee Reports > General.   

 

Figure 7-7 

Report Title 
Enter a title for the report. 
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Column 1 through Column 8 
From the drop down boxes select the data to be displayed in each column on the report. Each column control 
is a drop down list box, allowing you to select the data to be displayed on the report.  

Employee Selection 
Here you can select which set of employees to report. 

New/Open/Save 
The Quick List report allows you to save a report template for later use.  The report will save the title, each 
column as well as the employee selection to be printed. 

Export 
Export is a very powerful feature.  

Clicking the Export button will allow the user to export the specified data in the template to be exported to a 
file.   

Supported file types are: 

• .xls – Microsoft Excel.  

• .csv – Comma Separated files. Generally used for mail merges. 

• .txt - Windows text file, which can be used by Microsoft Word or Notepad. 

• .dbf – A database file. This is a very useful if you have a programming staff that can provide you with 
additional reports that do not exist in HR.  You can also export data from this format into Microsoft 
SQL.  
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HR has six categories of Employee Reports.   Each report will be explained in detail, grouped by category, 
with an example of each report.  

To access the reports, click Reports->Employee Reports on the toolbar.  Select the category of the report 
you want to view from the drop down list box.  Each report available for that specific category will appear.   

Award Reports 

Awards List 
This report lists all employees who have received an award.  For each award it displays date, type, person 
giving the award, and notes.  Additional information includes employee department and position. 

 

Figure 8-1 

Awards by Employee 
The Awards by Employee report lists all of your employees (by department) who have received an award. For 
each employee, the report shows the employee's department, position, achievements, and the date each 
award was received. 
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Figure 8-2 

Employees by Award 
The Employees by Award report lists all company awards and employees receiving each award.  For each 
award it also lists the employee receiving the award, the employee’s department and position, and the date 
the award was received. 

You can choose a date range for your report.  If you choose a date range, then only achievements awarded 
between the from date and the to date appear on the report.  By default, the report uses all dates. 

 

 

Figure 8-3 

Length of Service Awards 
This report lists all employees who have been employed for a specified number of years.  For each employee, 
the report displays the employee’s name, department, position, title, and hire date.  

You can modify your report by selecting various durations of service.  You can choose any or all of the 8 
service periods provided. 
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By default, the report prints the current year’s recipients only. If you want to list all employees who have ever 
received this award and the years they received it, uncheck the “This year’s recipients only” option.  
Employees will be listed by their most current award. 

 

 

Figure 8-4 

Benefit Reports 

Benefits Used by Each Employee 
This report displays all employees, by department, who are currently receiving a company benefit.  For each 
employee, the report also displays the employee's position, benefits received, and the start date for each 
benefit. 

 

 

Figure 8-5 

Company Benefits Available 
This report will show all of your company's benefits with a description of each.  It also displays when 
employees become eligible for each benefit and if the benefit continues after the employee is no longer 
employed. 
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Figure 8-6 

Employee Benefit History 
The Employee Benefit History report displays all of your company's benefits available for an individual 
employee.  The employee name, position, and department are displayed in the report header.  Information 
for active benefits includes current benefit status, eligible date, and start date.  Previous Benefit Activity 
includes status, past benefit activity (usage), reason stopped, and notes. 

 

Figure 8-7 

You can print this report for one employee or for all employees in a department.  To print this report for a 
department, select the department button.  Choose the department you want to print.  Each employee will 
appear on a separate page.  To print this report for all employees, select the department button and choose -
All Departments-.  

Employee Unused Benefit 
This report lists all employees (by department) who are currently not enrolled in a particular benefit.  The 
report will also show each employee's position, all unused benefits, and date eligible for each unused benefit.  
You can choose to report on one or all unused benefits. 
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Figure 8-8 

Employees Not Using Benefits 
This report is similar to the Employee Unused Benefit.  This report displays information (by benefit) for each 
employee eligible for a benefit but not currently enrolled in the benefit.  For each employee the report lists 
the employee's department, position, and eligible date. You can choose to report on a specific benefit or on 
all benefits. 

 

Figure 8-9 

Employees Using Each Benefit 
This report displays each benefit used and all employees enrolled in that benefit.  It also lists the employee's 
department, position, and the date enrolled for each benefit.  You can choose to report on a specific benefit 
or on all benefits. 
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Figure 8-10 

Single Benefit History 
This report displays history information about a specific benefit for an individual employee.  Benefit data 
includes Date Enrolled, Stopped, Stop reason, and Notes. 

 

 Figure 8-11 

Education/Training History Reports 

This report displays an employee's education and training.  The header displays the employee name, position, 
and department.  This report is divided into two sections, General Education and Additional Training. 

 

Figure 8-12 

General Education includes elementary school through graduate school.  For each school listed you will see 
the location of the school, the dates attended, date graduated, G.P.A, major, degree, and honors. 

Additional Training usually consists of job related courses or training.  Information displayed for additional 
training consists of training title, location of training, dates attended, grade, instructor’s name, and any 
additional notes. 
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You can print this report for one employee or for all employees in a department.  To print this report for a 
department, select the department button.  Choose the department you want to print.  Each employee will 
appear on a separate page.  To print this report for all employees, select the department button and choose -
All Departments-.  

Employee Training Summary 
This report displays all employees (by department) who have a training record. For each employee, the 
report will also display the employee's position, class attended, location of class, dates attended, and the 
grade they received. 

 

Figure 8-13 

Select the class from the Training Classes list.  You can also select a date range for your report.  If you 
choose a date range, then only training records between the from date and the to date will appear on the 
report.  By default, the report will use all dates. 

Training Attendance 
The Training Attendance report displays all training classes that are currently in your HR database.  All 
employees that have attended training classes are listed below each class along with their department, dates 
attended, and the grade they received. 

 

Figure 8-14 

Select the class from the Training Classes list.  You can also select a date range for your report.  If you 
choose a date range, then only training records between the from date and the to date will appear on the 
report.  By default, the report will use all dates.  

Training List 
This report prints a list of employees attending Training.  Training information includes, employee name, title, 
department, position, class date from, date to, location, instructor 



HR User Manual 92 
 

 

Figure 8-15 

Edu
cation List 

This report lists employee’s formal education. Education information includes employee name, title, 
department, position. Education level, date from, date to, school, location, degree, major, and honors. 

 

 

 

Figure 8-16 
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Employee Evaluation Reports 

This report prints an evaluation for an employee.  Evaluation information includes employee position, 
department, evaluator, and date of evaluation. 

 

Figure 8-17 

Scoring information includes actual score, max score, total max score, and percent score.  There is also a 
section for Employee and Evaluator Comments. 

 

Figure 8-18 

To print an evaluation, first select the employee name and then select the specific evaluation from the 
evaluation box. 

To print a blank evaluation, check the blank evaluation checkbox and then select the evaluation type. 
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Evaluation Category Summary 
This report lists all evaluation categories in HR with a description of each category. 

 

Figure 8-19 

Evaluation History 
This report displays evaluation information for each employee who has received an evaluation.  Information 
for each evaluation includes evaluation date, type, overall score, percentage, and evaluator.  Additional 
information includes department and position. You can also print this report from an employee’s Evaluation 
History screen. 

 

 

Figure 8-20 

Evaluation Ratings 
This report displays a ratings scale for your company.  Information includes scoring description and scoring 
range. 

 

Figure 8-21 

Evaluation Schedule 
This report lists all employees who are due for an evaluation within a given time period.  Information includes 
employee department, evaluation type, evaluator, score, and date of last evaluation.   



 Chapter 8 Employee Reports- 95 
 

 

Figure 8-22 

Employees who have never been evaluated are noted with an asterisk. 

Evaluation Selection 
This report displays all employees that have been evaluated.  For each evaluation, the report shows the 
employee's department, position, the evaluation type, the evaluator, evaluation date, points received for 
evaluation, and percentage score. 

You can also choose to report on a specific scoring range.  HR allows you to choose all scores, raw scores, 
and percentages.  Raw scores are a specific number out of a maximum (i.e. 120 out of a possible 160 
points).  Percentages are derived from the raw score (e.g. 80%). 

You can print a report for a specific evaluation type or for all evaluation types.  You can also choose an 
evaluation date range and an evaluation score range. 

If you are using Alternate Scoring Codes (Settings > Configuration), then the Evaluation Selection Report 
lists all evaluations by evaluation scores. 

 

Figure 8-23 
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General Reports 

Certification List 
This report lists all employees who have a certification.  Information for each certification includes 
certification name, number, and expiration date. 

 

Figure 8-24 

Employee Address History 
The Address History report displays all past and present addresses for all employees.  Address information 
includes street, city, state, zip, and date. 

 

Figure 8-25 

Employee Information 
The Employee Information report displays data from each of the 14 Employee File categories. You can select 
which categories to report on from the category list.  Only the selected categories will report data. 
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Figure 8-26 

You can choose to report on one or multiple employees.  To select more than one employee, check the 
multiple employees’ checkbox.  Selecting multiple employees allows you to use the selection criteria to decide 
which employees to print.  If you do not choose any selection criteria, then Employee Information will report 
on all employees. 

When previewing multiple employees, you will only be able to preview information for the first employee.  
You can also print a blank report using the blank sheet checkbox.  

Employee Work History 
The Employee Work History report displays complete employee work history records. Data includes employee 
name, department, position, supervisor, compensation, date range for each record, reason for record change 
from previous record, and job status. 

 

Figure 8-27 

You can also print an employee's work history record from Work Info. 
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Miscellaneous Information 
This report displays the content of each employee's Other Information record.  Information includes EEO 
code, disability, military status, payroll #, work permit data, I-9 data, union data, and general notes.  

 

Figure 8-28 

You can also print this report from an employee's Other Information screen. 

Monthly List of Work Changes 
This report displays changes in work history records for a specific month or an entire year.  Work information 
includes employee name, reason for change, change date, job status, compensation, position, and 
department. 

 

Figure 8-28 

Select the month and year you want to view.  If you want to print all months for a given year, select the year 
and make sure that the print entire year checkbox is marked. 
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Personal Information  
This report displays Personal Information for all employees.  Personal information includes employee name, 
date of birth, sex, SSN, phone numbers, email, marital status, former name, marriage date, and spouse 
information. 

 

Figure 8-29 

You can also print an employee Personal Information report from Personal. 

Quick List 
Quick List is a simple report writer.  It allows you to choose up to eight categories to report on. Use the drop 
down list box to select a category.  You can choose from such categories as position, department, position, 
job status, birth date, hire date, social security number, home phone, work phone, fax, e-mail, and other user 
defined fields.  You can also choose to have a column omit any data. 

 

Figure 8-30 

The above figure shows an example of a Quick List report using the Employee Directory template.  Quick List 
comes with eight pre-defined templates.   

HR will not remember any changes you make to a template including Report title and Column 
selection, unless you save the template. 
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Union Directory 
The Union Directory report lists all unions currently in your HR database as well as each employee in that 
union.  Additional information includes employee title, position, department, and union number. 

 

Figure 8-31 

Attachment List 
The report shows all related attachments to an employee and includes the name of each attachment, the date 
the attachment was added to HR, the filename of the attachment and a comments about the attchment. 

 

 

Figure 8-32 

Warning Reports 

Department Warning Summary 
This report lists all employees (by department) who have received a warning.  Additional information includes 
employee position, warning type, and date of warning. 

 

Figure 8-33 

You can select a specific type of warning to view.  Select the warning from the warning type list.  
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Formal Warning 
This report prints a formal warning for an individual employee.  Each warning includes the employee's 
department, position, job status, the person who issued the warning, and the date the warning was given.  
Each Formal Warning also includes the details of the infraction, any action taken, and employee comments. 

 

Figure 8-34 

You can also print an employee Formal Warning report the Warning Details screen. 

Choose the employee from the Employee Names list.  Select the specific warning you want to print from the 
warning list.  To print a blank warning, check the Blank Warning checkbox.  

Warning History 
This report displays warning information for each employee warned.  Warning information includes date, type, 
and name of issuer. 

 

Figure 8-35 
 

You can also print an employee Warning History report from an employee’s Warning screen. 
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Warning Summary 
This report lists all employees who have received a warning by the type of warning received.  Additional 
information includes employee department, position, and warning date. 

 

You can select a specific type of warning to view.  Select the warning from the warning type list.   

 

Figure 8-36 
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CCChhhaaapppttteeerrr   999   OOOrrrgggaaannniiizzzaaatttiiiooonnn   RRReeepppooorrrtttsss   
 

HR has six categories of Organization Reports.  Each report will be explained in detail, grouped by category, 
with an example of each report.   

To access the reports, click Reports->Organization Reports on the toolbar.  Select the category of the 
report you want to view from the drop down list box.  Each report available for that specific category will 
appear.   

Administration Reports 

Security Summary 
This report lists HR users and their access levels. 

 

Security List 
This report lists all HR users and the departments they can access. You can also print this report from the Security screen. 

 

 

 

 

Figure 9-1 

User Code List 
This report lists all user options for the 22 user code categories. 
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Figure 9-2 

You can also print this report from the User Codes screen. 

User Code Report 
This report lists all employees currently assigned a particular user option.  First select the user code category 
from the category list and then select the user option from the list box entry.  The header displays the user 
option information. Figure 9-3 shows all instances of Job Status Code type matching “Full Time”. 

 

Figure 9-3 

Vital Data Omitted 
This report lists all employees who have vital data missing from the database.  Vital data includes first name, 
hire date, department, position, job status, social security number, current salary, phone number, emergency 
information, and current address. 
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Figure 9-4 

Compensation Reports 

Department Salary Profile 
This report displays company salary information by department.  Information for each department includes the 
number of employees and the total amount of salaries paid to that department.  Other information includes 
percent of midpoint, actual salary, and planned salary.  You can print this report for one or multiple departments. 

 

Figure 9-5 

Actual salary figures are based upon employees’ salaries in that department.  The minimum department 
salary is the lowest actual amount that an employee in the department receives. The maximum department 
salary is the highest actual amount that an employee in the department receives.  The average salary is the 
average salary for all employees in the department. 

 

Planned salary consists of a calculated minimum, maximum, and midpoint.  These figures are based upon the 
amounts specified in Positions and the number of employees in each department. The minimum salary is the 
lowest amount specified for a position in the department. The maximum salary is the highest amount specified 
for a position in the department.  The midpoint is calculated from the planned midpoint salaries of each 
employee in the department.    

 
Example  

The Applications Programming department has 2 employees. The planned midpoint is 49,045. The total 
midpoint for all two employees would be $98k.  The planned midpoint for the Application Programming would 
be $98k divided by the 2 employees, or $49k. 
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The percent of midpoint amount is calculated from the actual average salary divided by the planned midpoint. 

Employee Compensation Status 
The Employee Compensation Status report displays each employee’s salary information.  This includes current 
salary, amount of previous salary, date current salary became effective, and reason for salary change.  The 
report also shows date of last evaluation, percent of midpoint, position, and department.  The percent of 
midpoint is calculated from the employee's current salary divided by the position's planned midpoint. 

 

Figure 9-5 

You can choose which employees to print by selecting one or more departments or positions.  To show only 
the employees who have not been evaluated since a specific date, select exclude recent evaluations. 

The sort order box allows you to choose the order of the records.  By default, the records will be sorted first 
by name, and then by evaluation date, position, and department.  To change the sort order, click the field 
you want to move, hold the left mouse button down and drag it to its new position.  For example, if you want 
to first sort the records by department, you would click department and drag it to the name field position. 

Employee Over/Under Budget 
This report shows all employees whose current salary is either lower than their position's planned minimum 
or higher than their position's planned maximum.  If a salary is below the position's minimum, the report will 
display the percentage under the minimum. If a salary is above the position's maximum, the report will 
display the percentage above the maximum.  (The positions table specifies the position minimum, and 
maximum.) 

 

 

Figure 9-6  

Employee Salary Profile 
This report displays each employee's name, position, current salary, and the relationship between their salary 
and their position's planned salary. The percent of midpoint is calculated from the employee's current salary 
divided by the position's planned midpoint.  Additional information includes planned minimum, midpoint, and 
maximum salary. 
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Figure 9-7  

Relationship to Salary Schedule shows how an employee’s salary relates to the position’s planned salary.  
The first column signifies all employees whose salary is less than the position’s planned minimum.  The 
second column shows all employees whose salary falls between the position’s planned minimum and 
midpoint.  The third column shows all employees whose salary falls between the position’s midpoint and 
maximum.  The last column shows all employees whose salary is more than the position’s planned maximum.  
Any employee whose salary is equal to the position’s planned amount will not appear in the relationship table 
and the corresponding position amount will be shaded in yellow. 

 

Position Salary Profile 
This report (similar to Department Salary Profile) displays salary information for each position.  Information 
includes position name, number of employees in each position (count), total salaries paid to employees in that 
position, and the minimum, average, and maximum actual salaries paid.  You can print this report for one or 
multiple positions. 

 

Figure 9-8  

Actual salary consists of a minimum, average, and maximum amount.  The minimum is the lowest amount an 
employee in that position receives.  The maximum is the highest amount an employee in that position receives. 
The average is determined from all of the employees in that position and their actual salaries.  

Planned salary figures are based upon the amounts specified in Positions.  The percent of midpoint is 
calculated from the position's actual salary average divided by the planned midpoint. 

Salary Planning Worksheet 
The purpose of this worksheet is to help you project future salaries.  The first three columns show the actual 
data for each department, including number of employees in each position, actual average salary, and total 
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salaries.  The second group of columns displays planned information for each position including actual number 
of employees in each position, planned midpoint, and current budget for the position.  The current budget is 
calculated from the number of employees in the position times the planned midpoint. 

 

The last group of columns is a worksheet for you to complete.  It is similar to the previous two columns.  You 
can also add additional positions and projected data in this worksheet.  

 

Figure 9-8 

Summary of Salary Changes 
This report is similar to the Employee Compensation Status report.  It lists salary information for each employee 
including current and previous salary amounts for a particular date range.  It also lists the reason for and 
amount of each salary change.  Additional information includes date of salary change, reason, employee's 
department, position, supervisor, and total compensation changes for the date range specified. 

 

Figure 9-9 

Years of Service Profile 
This report displays information based on length of employee service.  You can choose the row category and 
cell data you want to display.  Row categories include employee name, position, title, and department.  Cell 
data includes salary average, headcount, and percentage. 
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Figure 9-10 
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Head Count Reports 

Headcount Summary 
This report lists the number of employees per job status in each department and position.  It also displays the 
total number of employees in each department and position as well as a summary for your entire company 
with job status totals. 

 

Figure 9-11 

 

Figure 9-12 

 

Figure 9-12 
 

 

You can choose to print data for a specific job status.  Select the Summarize for only one job status 
button.  A drop down box will appear.  Select the job status you want to display. 

Monthly List of New Hires 
This report displays new employee information for a particular month or an entire year by department.  
Employee Information includes name, date of hire, title, position, job status, supervisor, and compensation. 
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Figure 9-7 

Monthly List of Terminations 
This report displays terminated employee information for a particular month or an entire year.  Employee 
Information includes name, social security number, last position, last department, last supervisor, last 
compensation, and termination date. 

 

 
Figure 9-15 

Previously Held Positions 
This report lists all of the employees that were previously in a particular position.  This report includes date 
range information, previous department, previous supervisor, current position of employee, and current 
department. 

 

Figure 9-16 

User Defined Categories 
This report displays user defined field information for each employee (see User Codes). 

 

 

Figure 9-17 

You can also print an employee User Defined Categories report from the Employee Files - User category. 
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Legal Reports 

Certification by Employee 
The Certification by Employee report lists all company certifications (by department) that will expire within a 
specified date range.  Information includes employee name, position, title, and certification type, certification 
number, and expiration date. 

 

Figure 9-18 

You can choose to print information for a particular certification or for all certifications.  You can also specify 
an expiration date range or print all certifications. 

Certification Renewal 
This report lists employee information by certification type.  Employee information includes name, 
department, position, title, certification number, and expiration date. 

 

Figure 9-19 

You can choose to print information for a particular certification or for all certifications.  You can also specify 
an expiration date range or print all certifications. 

EEO Age Group Analysis 
This report shows the number of employees in each age group for each position.  It also lists position and age 
group totals.  Age groups include under 21, 21-30, 31-40, 41-50, 51-60, 61-65, over 65, and unlisted. 
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Figure 9-20 

EEO Breakdown 
This report lists the total number of employees by EEO code, age group, sex, disability, and military status.  
Statistics include totals for each category.   

 

Figure 9-22 

EEO Promotions 
This report lists the EEO category of employees receiving a promotion.  A promotion is any work change that 
includes a reason change of “promotion”.  Information includes employee's social security number, sex, EEO 
class, new position, and promotion date. 

 

You can print information for a specified date range or for all dates. 
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Figure 9-23 

Employee Work Force Analysis 
This report displays EEO statistics for each position.  Information includes EEO class name, number of males, 
number of females, and unclassified per EEO class.  Additional information includes percent of males, females, 
and unclassified per position. 

 

Figure 9-23 

I-9 Report 
This report lists all employees who have filed I-9 information.  Data includes SSN, department, position, title, 
hire date, and I-9 filing date. 

 

Figure 9-24 

New Hire Detail Report 
This report lists all employees by position and date hired.  Additional information includes department, EEO 
code, sex, social security number, position, and compensation. You can print information for a specified date 
range or for all dates. 
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Figure 9-25 

Veterans Employment: VETS-100 
This report lists the number of disabled veterans and Vietnam era veterans for each position as well as totals 
for the entire company. 

 

Figure 9-26 

Work Permit Renewal Status 
This report lists all employees with a work permit. Information includes work permit number, expiration date, 
permit status, social security number, department, position title, and date of hire. 

 

Figure 9-27 
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Organization Reports 
Check List 
This report allows you to select a checklist to print. Information on the list includes task, complete checkbox, 
date field, and initials field.  

 

Figure 9-28 

You can also print a checklist from the Check Lists screen. 

Department Heads 
The Department Heads report lists the department manager, assistant, department notes, and headcount for 
each department.   

 

Figure 9-29 

You can also access this report from the Department screen. 

Department Roster 
This report displays employment information for each department.  Information includes department head, 
department assistant, employee name, headcount, and compensation.  Data for each employee includes title, 
position, job status, compensation, and supervisor. 
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Figure 9-30 

Phone Directory (Condensed) 
 
This report lists all employees alphabetically with their home telephone numbers.  (See also Phone Directory 
report later in this chapter.) 
 

 

Figure 9-31 

Position List 
This report displays the salary information for each position including minimum, midpoint, maximum, pay rate 
and exempt status.  Additional information includes position description. 
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Figure 9-32 
 

You can also access this report from the Positions screen. 

Position Roster 
This report displays employment information for each position.  Information includes names and number of 
employees assigned to position and total compensation.  Data for each employee includes title, department, job 
status, compensation, and supervisor. 

 

Figure 9-33 
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Organization Attachment List 
This report displays the attachments at the company level. You may use the following screen to add company 
attachments: 

 

 

 

 

Figure 9-33 

 

 

Personal Reports 

Birthdays 
This report displays all employees' birthdays for a given month or year. Information includes birthday day of the 
week, calendar day, employee position, and department.  You can also choose to print employees without 
birthdays. 
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Figure 9-16 

Dependent Roster 
This report displays dependent information for each employee who has a dependent.  Dependent information 
includes name, relation to employee, date of birth, age, dependent type, address, phone number, and notes.  
Additional information includes employee's social security number and marital status. 

 

Figure 9-16 

You can also print this report from an employee’s Dependent screen. 

Emergency Information 
This report lists all employees by department with their emergency information.  Emergency information 
includes up to two people to contact in case of an emergency, their relationship to employee, contact's phone 
number and address, and special information such as employee allergies or medical conditions.  Employees 
without emergency information will also appear on the report. 

 

Figure 9-36 

You can also print this report from an employee’s Emergency Information screen. 
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Labels (Avery 5160) 
This report will print labels for mailing to employees on Avery 5160 labels. 

 

Figure 9-37 

Married Employees' Spouse Data 
This report will display spouse information for married employees.  Spouse information includes name, 
maiden name (if applicable), social security number, date of birth, and wedding date. 

Figu
re 9-38 

Phone Directory 
This report lists all employees alphabetically along with their home telephone numbers and their address 
information.  See also Phone Directory (Condensed) 

 

Figure 9-39 

 

Social Security Number Listing 
This report lists all employees and their social security number.  Additional information includes payroll number, 
title, position, and department. 
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Figure 9-40 

Wedding Anniversaries  
This report displays employee wedding anniversary information by month.  Information includes employee 
name, wedding date, years married, employee position, department, and address. 

 

Figure 9-41 

You can choose to print an entire year (default) or one month.  You can also choose to print employees without 
anniversaries.
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CCChhhaaapppttteeerrr   111000   UUUtttiiillliiitttiiieeesss   
 

Importing 
HR supports importing data from a variety of other software programs and other versions of Software 
Techniques Human Resources Systems. There are two options in HR for importing data into your SQL 
database. 

Under the file menu there is a utility for importing data into your HR database. Before using this utility you 
will need to setup your data as you want it. This utility is primarily used to import a generic data file or data 
from E-2000 to your HR database that you have already setup. This can even be used to add employees to a 
HR database that you are using. 

To use this utility you must be operating in Super Administrator mode. 

To begin importing data, select File->Import from the menu. HR features an Import Wizard to lead you 
through the steps of importing your data. 

 

 

Figure 10-1 
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Generic Data File 
With a generic data file, you can choose to import either employees or departments. 

 

Figure 10-2 

Next you must choose the Generic Data File to Import. It is helpful to use the first row of your import file as 
headers. 

These will display the next step where you have to map the column names. Generic Data File types can be 
xls, txt, csv, dbf, etc. 

 

Figure 10-3 

With generic data file imports, you will need to match the HR Fields to the fields in the import file. HR will try 
to match the fields as best it can. All of the fields do not have to be matched, but to move to the next step, 
you must match up the name field. You can match up fields by selecting a field and using the << and >> 
buttons or by dragging and dropping between the lists. 
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Figure 10-4 

Duplicate Handling tells HR how you wish it to handle duplicate records that it comes across. Your choices 
are to skip or to allow duplicate records. Skipping will not import a record identified as a duplicate. Allowing 
duplicates will import the record and you can review both records in HR to determine which is valid.  Merging 
duplicates will check the database to see if the Name+Hire Date combination already exists.  If it does, the 
imported data will be added to the current data. 

 

 

Figure 10-5 

Press the Next button to move to the last page. 
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From here click the Finish button and the Import will begin. Depending on the number of employees you 
have, the import process may take several minutes. 

 

Figure 10-6 

Importing from E-2000 
Importing from E-2000 is very similar, but there is one less step. From the first screen, select E-2000.  You 
will then be prompted to specify where the E-2000 executable is located. 

 

After you click next, you will see the Duplicate Handling page as shown above.   

Note – If you currently have a SoftTime or TimeKron database and are importing your E-2000 
database, you should choose Merge Duplicates!  If you do this, then your E-2000 employees will be 
imported into your current SoftTime/TimeKron/HR employees. 

Then you will just need to click Next one more time to get to the final page and click Finish. The E-2000 
import should then begin. 
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Exporting 

 

Figure 10-7 

There are two ways in which to export from HR, from the Quick List screen or from File->Export on the 
toolbar.  In both cases the Quick List screen will appear.  Select the 8 column of data you would like to 
export, click Export.  An  EXCEL spreadsheet (.xls) will be created.  This data can now be manipulated 
externally. 
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Advanced Export 
 

 

Figure 10-8 

The normal export allows you to export data for which there is one and only one record for each employee 
(Social Security Number, Gender, Hire Date, etc.).  The Advanced Export allows you to export data where 
there is more than one record for each employee.  Things such as Award, Warnings and Evaluation can be 
exported using this utility. 

On the left side of the screen, select the group of employees you wish to export.  On the right side, select 
how you want the employee identified in each record.  Then you can choose the category that you want to 
export from. 



 Chapter 11 Trouble Shooting - 129 
 

 

CCChhhaaapppttteeerrr   111111   TTTrrrooouuubbbllleee   SSShhhooooootttiiinnnggg   
 

Help Menu 

 

License Agreement 
The License Agreement can be seen at the beginning of this manual.  

Upgrade License 
This utility allows you to upgrade your number of user licenses for HR.  This screen will display your current 
activation code and your current number of licenses.  You can still call Software Techniques or your HR reseller 
and purchase the additional codes, and you will be given a new activation code to upgrade to the newly 
purchased number of user licenses.  
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Figure 11-1 

Once you enter the new activation code and click OK, HR will exit.  The next time you enter the program, the 
new number of user licenses will be activated. 

Web Update and Automatic Upgrades 
This feature allows you to automatically check www.softwaretech.com for recent upgrades and patches.  If you 
would like to set the interval for performing these checks, you can run the Web update option from the Help 
Menu.  

 

Figure 11-2 

If a new version is available via the web an Icon will appear in the bottom right corner of the main screen:  

 

 

http://www.softwaretech.com/
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To download the web update, click the web update icon . This will do two things. First it will download the 
update files to the auto-upgrade directory on your network. You will need to have read/write and file creation 
access to this directory to successfully download updates. Once the files are downloaded they will 
automatically be installed on your workstation. You will need to restart HR. Most upgrades will not require you 
to reboot. 

Each time you attempt to login to HR, the software will automatically check the auto-upgrade directory to see 
if your workstation is running the most recently downloaded version of the software. If you need to upgrade 
your workstation you will see a screen that will require you to update. 

 

As you upgrade your old HR executable will be backed up and a progress bar will de displayed.  After 
completing the upgrade you will have to restart HR. 

 

Sometimes an upgrade will require that the SQL Database is also upgraded.  HR constantly checks the SQL 
database to make sure it is compatible with the software.  If the database and the application become out of 
sync, you should have your DBA run HR in DB administration mode. 

Software Techniques on the WEB 
This option launches your default Web browser to Software Techniques Inc. main Internet site. The web URL 
is http://www.softwaretech.com. 
 

http://www.softwaretech.com/
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STI Website 

About HR  
The About HR screen gives information about your installed version of HR.  It is useful if you ever need to 
make a support call to give your version, serial number etc. 

 

 

DB Administration Mode 
When you run in DBAdmin mode the DBA will have access to the Configure button.  For more information 
about the DB Administration mode, check out Chapter 2-Installation and Setup. 
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Customer Support 
If the information you need to solve a problem is not in the manual, please do the following: 
 

1. Review the list of Common Problems and Solutions that follow, to see if your problem is there 
 

2. You can also receive on-line support via our Technical Support Web Page on the Internet at 
http://www.softwaretech.com. Product support is free for the first 15 days that you own HR. 
Beyond that time, support and E-mail calls are billable. 
 

3. Refer to the Microsoft Windows User Manua l for he lp with problems caused by the  ope ra ting 
environment or the Windows Graphic User Interface. 
 

If steps 1-3 were not able to help, you may call Software Techniques Inc. at (540) 721-1002 for technical support. Our 
staff is on duty Monday through Friday, from 9:00 AM - 12:00 PM and 1:00 PM - 5:00 PM, Eastern Time. You may also 
FAX your questions to us at (540) 721-1010. Before you call, though, complete the following steps: 
 

1. Be sure you are eligible. Product support is free for the first 15 days that you own HR. 
Beyond that time, support and E-mail calls are billable. 
 
2. Have the HR SQL serial and version numbers handy. You can find them on the installation 
CDs, and copy them here: 
Activation Code _____________________ Version # ________ 
 
3. Note the amount of available disk space on your drive, _____________ and the amount 
of RAM on your computer _________________. Also, note the available disk space within 
your common directory ____________. 
 
4. Verify your ODBC connection is working properly. Write down the name of the SQL Database 
you are connecting to. [____________________] (It should appear on the main screen in 
[brackets]). 
 
5. A problem may be database related so have your SQL DBA near by in case he/she needs to 
be consulted. Also make sure you have full read/write/create privileges to your common 
directory. 
 
6. If an error has occurred, write down the first error message exactly as it appears on your 
screen. Write down the steps you took just before the error message appeared. 
 
7. Be prepared to provide our Customer Support staff with any information they need. HR 
generates a log file that may help us diagnose complex problem. We may ask you to send 
this file to us for analysis. 
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Common Problems and Solutions 
My Password doesn’t work. 

The first time you log in, the system defaults to a User Name of “Admin”. No Password is required. Just 
press Enter and you will be logged in to the software. At this point, you can set up individual User Names and 
Passwords by clicking on the Employee Information tab. 

Remember, the password field is case sensitive. Check your caps lock key. You can also adjust your 
workstation options for each individual workstation. 

 
Error Message - Cannot locate FoxPro Support Library. 
 

The computer does not have the FoxPro DLL files installed. These can be obtained by reinstalling the 
software. Make sure the data files are backed up before reinstalling. 

 
Computer freezes when trying to load HR. 

 

You workstation probably does not meet the minimum requirements. Make sure that no other programs are 
running in the background. If the problem still occurs, change the display on the video driver to a standard 
Super VGA display. 

 
Error message: 
 

“Unable to login to HR SQL Server. Common directory does not exist.” 

You are unable to connect to the common directory. If it is on a network, make sure you are properly 
connected and logged in to that network. 

Check your network cable. If the problem continues contact your network administrator. 

 
Error message: 

 

“Unable to login to HR SQL Server. Invalid ODBC Connection.” 

You are unable to connect to the SQL Database. This may be because your SQL Server is down or because 
your SQL account does not let you connect to the database. If the problem continues contact your SQL DBA. 

 
Error message when trying to login: 
 
“SQL Command w/ error [UPDATE ...]”. 
 
The SQL DBA has restricted your use of the database (permission) such that you cannot properly access the 
database in the required fashion. It has been altered into an unusable format. Have your SQL DBA run HR in 
DB Admin mode and use the configuration tools to repair the problems. 



 Chapter 11 Trouble Shooting - 135 
 

 
Printer display reads: Memory Overload. 
 
Turn the printer Off and On. Go to your desktop, click Start-Settings-> Control Panel->Printers. Reduce 
the print resolution to the next lowest level. Set up the report for printing again. 
Also, 2MB of printer memory is recommended. 

 
Error Message - Unable to Write to file named _________. 
 
HR cannot write to your hard drive or to the common directory. The most common problem is insufficient 
disk space. Free up some disk space. This can also occur if your network administrator has restricted your 
access to the common network directory 

 
Error Message during installation - Unable to Read _________. 
 
This may be a bad CD or a bad CD Drive. First remove the CD and reboot your computer. Reinsert the CD 
after you have logged back into Windows. 

 If the problem continues call Technical Support and report the 
exact error message that appears. The technical support staff can issue you a new CD. 

 
Error Message - Unable to Update Cursor. 
 

The user logged on to the network does not have read/write access to the common data directory. This is 
most likely a network rights issue. 

 
Installation or Update Error Message - Can’t change properties of file named _________. 

 

User requires write access to the Windows directory so that HR can automatically update the .DLL files 

 
Sometimes the menu options are disabled and I cannot click them. 
 
You probably have too many screens open. Close some screens down. After importing, HR asked me if I 
wanted to exit and I said no, HR exited anyway. Why? After importing, it is always best to exit and restart HR. 
This is to ensure that the import was successful. 

 
Error message: “Unable to login to HR SQL Server. Base data is incomplete”. 

The SQL database has been altered into an unusable format. Most likely a critical table has been deleted. 
Have your SQL DBA run HR SQL in DB Admin mode and use the configuration tools to repair the problems. If 
data has been lost have your SQL DBA restore a SQL backup. 

 
 
Error message: “SQL Command w/ error [SELECT ...]”. 
The SQL database has been altered into an unusable format. Have your SQL DBA run HR SQL in DB Admin 
mode and use the configuration tools to repair the problems. 
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Some words in HR may be cropped. 
 
The font size on the video card is set to large fonts. Change the font size to small fonts.

 
One or more employees appear to be “locked” when they shouldn’t be. 
 
The lock table was not updated properly.  Go into HR as a Database Administrator and click Configure in the 
Login screen.  Move to the Check Data step and click the Clear all Locks button. 
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Administration, 13, 19, 25, 28, 82, 105, 134 
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Assistant, 33, 72, 73, 74 
Attendance, 69, 91 
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133, 134 
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All Dates, 78, 80, 86, 91, 102, 113, 114 
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dbf, 84, 124 
Degree, 74 
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Removing, 40 
Salary Profile, 107 
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age, 59, 120 
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type, 59, 120 

Destination Folder, 12 
Directory, 12, 13, 17, 26, 99, 117, 121, 131, 133, 

134, 135 
Common, 12, 13, 17, 20, 21, 26, 44, 133, 134, 

135 
Disability, 64, 75 
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Editor, 27 
Education, 60, 74, 90, 92 
EEO, 40, 64, 75, 98, 112, 113, 114 
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eligible, 41, 74, 87, 88, 89, 133 
Email, 27 
E-mail, 27 
E-mail, 28 
E-mail 

Configuration, 28 
E-mail, 28 
E-mail, 34 
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E-mail, 34 
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E-mail, 35 
E-mail, 35 
E-mail, 35 
E-mail, 35 
E-mail, 35 
E-mail, 35 
E-mail, 75 
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E-mail, 79 
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Employees 
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Ratings, 94 
Schedule, 94 
Scoring, 27, 31, 36 
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Type, 42, 62, 74 
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Exit, 33 

Warning, 33 
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Data, 28, 84, 127, 128 
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Hard Drive, 9 
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Help, 129, 130 
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I-9, 64, 75, 98, 114 
Importing, 28, 123, 124, 126 
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Installation and Setup, 7, 9, 132 
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Status, 67, 75, 81, 83, 104 
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Length of Service Awards, 86 
License, 13, 25, 28, 129 
license agreement, 13, 20 
License Agreement, 13 
Logging on, 13, 19, 20, 24, 26, 136 
logo, 32 
Logo, 32, 78 
Low Resolution 

Printer, 32, 78 
Reports, 78 

Low Resolution Printer, 32, 78 
Mail Server, 34 
Manager, 73 
Marriage Date, 75 
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maximum, 9, 25, 40, 62, 95, 105, 106, 107, 117 
medical conditions, 61, 120 
Menus 

Help Menu, 129, 130 
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Military Status, 64, 75 
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Former, 75 
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New Hires, 110 
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ODBC, 13, 21, 133, 134 
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Categories, 73 
Operating System, 7, 9, 13, 19, 29, 84, 133, 135 
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103 
Reporrts, 7, 77, 103 
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Printing, 32 
Problems, 133, 134 
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Hardware Requirements 
CPU, 9 

Promotions, 113 
Quick List, 83, 84, 99, 127 
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RAM, 9, 133 

Rate, 40, 73 
Read Only, 30 
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reason stopped, 88 
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Removing 
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Renewal, 112, 115 
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Profile, 105, 106, 107 
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order, 106 
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Support, 35, 133, 135 
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Date, 67 
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TimeKron, 31, 69, 80, 126 
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Tools, 7, 31, 32, 34, 36, 37, 71, 72, 76 
Training, 65, 75, 90, 91 
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Trouble Shooting, 7, 129 
Troubleshooting, 7, 129 
Type, 40, 42, 75 
Union, 64, 75, 100 
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Codes, 27, 37, 104, 111 
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Formal, 101 
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Web Update, 28, 130 
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Deletion Warning, 33 
Deletion Warning, 33 
Exit Warning, 33 
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PROGRAM LICENSE AGREEMENT 

 
 

Copyright/License/Warranty 
HR/Diamond and/or HR/SQL Server Edition® Copyright © 2016 by Software 
Techniques Inc. All rights reserved. 
 

License Agreement 
 
One registered copy of HR/Diamond and/or HR/SQL Server Edition may be used 
simultaneously by multiple people not to exceed the number of authorized users 
specified by the product purchased.  Whereby the number of authorized users 
concurrently operating the program is subject to purchase license. 
 
You may access the registered version of HR/Diamond and/or HR/SQL Server Edition 
through a network, provided that you do not exceed the total number of users set forth 
by the product. 
 

Governing Law 
The laws of the Commonwealth of Virginia shall govern this agreement. 
 

Disclaimer of Warranty 
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR 
ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.  In particular, 
there is no warranty for any data entered into HR/Diamond and/or HR/SQL Server 
Edition.  Because of the various hardware and software environments into which 
HR/Diamond and/or HR/SQL Server Edition may be put, NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE CAN BE OFFERED. 
 
ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT. 
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